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Definitions  

 
 
 

 

KATC = Kalliope Attendant Console 

Local user = the user of KATC, whose credentials must be entered in the application 

settings screen 

Interlocutor = the telephone user (internal or external) who is in communication with 

the local user 
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Chapter 1 - Introduction 
 

KalliopeATC (from now on called KATC) is an accessory application of the VoIP KalliopePBX that 
combines the KalliopePhone features with the operator station features. 

KATC is available for S.O. Windows. 

Below we summarize the list of the main functionalities: 
 

 

Kalliope Attendant Console functionalities 

Extensions phonebook 

Shared phonebook 

CDR 

Inbound call notification 

Chat 

Presence 

Opening a custom URL for inbound calls 

VoiceMail Access 

Copy-to-call 

Drop-to-call 

BLF 

Blind transfer 

Queue statistics 

Inbound call classification 

Attended transfer 
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Do Not Disturb 

Call recording 

Unconditional forward 

Call Parking 

Call pickup 

Forking to Mobile 

Pickup with invite 

Drag&Drop call transfer 

Touchscreen support 
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Chapter 2 - Installation and configuration 
 

 
 

KalliopeATC is an application purchased separately from KalliopePBX and can be 

activated by assigning a specific license. Through the Configuration Panel, it is possible 

to enter the extension’s credentials registered on KalliopePBX; the system will 

automatically check the presence of the respective license. 

 

 
 

 

Note: The installation does not require the insertion of any activation 

code. The application automatically checks the presence of the license on 

KalliopePBX at each startup. 

 
To configure licenses on KalliopePBX Phone System, please refer to the KalliopePBX 

'Administration and Use' manual. 

2.1 Installation 
 

System Requirements: 

• OS. Windows XP SP3 or later, Ubuntu 12.04 (32 or 64 bit), Mac OSX (Mountain Lion version 
or higher) 

• Sound card (for KATC Phone mode) 

• 2 GB RAM 

• 40 MB of free disk space 

 
Launch the executable and follow the instructions to install the application in Windows. 

 
 

2.2 Changing application settings 
 

The first time the application is started, the message shown in Figure 1 will appear, 

indicating that configuration parameters need to be entered. 
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Figure 1 - Notification message of the missing configuration file 

 
Next, the configuration screen shown in Figure 2 will automatically open. The 

configuration menu is grouped by functional categories, each with one or more 

configurable parameters. 

 

 

Figure 2 - Settings Panel 
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2.3 Application Mode 
 

In this section, you can select the mode you want the application to run: Kalliope 

Attendant Console CTI or Kalliope Attendant Console Phone. You can also choose the 

interface language (Italian, English, or Spanish). 

2.4 Kalliope Attendant Console Settings 
 

The parameters that can be configured in this section are the following: 

• KalliopePBX IP address: the IP address assigned to the KalliopePBX you want to 
connect to 

• KATC Username: the name given to the user 

• KATC Password: the password assigned to the user 
 
 

 
 

Note: Username and password match the credentials configurable on 
KalliopePBX in the "System → User Management" panel 

 

2.5 Kalliope Attendant Console Services 
 

The parameters that can be configured in this section are the following: 

• Copy-to-Call Service: enables/disables copy-to-call service. When enabled, the 

user can call by selecting the string containing the number and copying it to the 

clipboard (in Windows, by CTRL+C). Once the string has been copied, the 

application will automatically strip spaces and other special characters (# + , : () . 

/\) and request confirmation before placing the call. 

• Drop-to-Call Service: allows the enabling/disabling of the Drop-to-Call service. 

The application triggers a call by dragging a text string containing the call number 

when enabled. The application automatically removes spaces and special 

characters (# + , : () . /\)
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• Import Microsoft Outlook contacts: if selected, KCTI will automatically 
synchronize Microsoft Outlook contacts when opened. The imported contacts 

will appear in the phonebook marked by the icon  . 
• Start minimized as a system icon: the application will open in minimized mode if 

selected. 

• Enable call reception popup: enables or disables the call receipt notification 
popup. 

2.6 Phone Integration 
 

In Kalliope Attendant Console CTI mode, it is possible to control the associated 

telephone system through the native APIs. This feature is currently available only with 

Snom and Yealink phones. 
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2.7 Automatic Actions 
 

Figure 3 - Event configuration screen 

 
In this tab, you can manage the behavior of the application during inbound calls by 

configuring actions triggered by the following events: 

- Arrival of a call (same as ringing) 

- Answering a call: the event is triggered when the inbound call is answered 

- End of a call: the event is triggered when the call is ended (both from local and 

remote users). 

 

Each of these events can be associated with one or more automatic actions, which can 
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be of two types: 

- Open a custom URL 

- Execution of an external process 

In both cases, you can use the following dynamic parameters in the actions: 

- <callername>: this parameter will be replaced by the name assigned to the caller if 

present in the phonebook 

- <callernum>: this parameter will be automatically replaced by the number of the 

caller 

- <extenNum>: this parameter will be replaced by the extension number of the local 

user 

- <uid>:  this parameter will be replaced by a unique call ID 

Figure 3 shows the automatic events configuration screen.  

 

The table at the top of the panel contains the list of configured actions, indicating for 

each of them the event type ("IN" = arrival of a call, "RIS" = answering a call, "FIN" = end 

of a call), the type of action ("EXE" = execution of an external process, "URL" = opening 

of a dynamic URL) and the detail of the action. 

Once an action has been saved, it is always possible to modify or delete it by selecting it 

in the table and clicking on Edit Action/Delete Action. 

You can indicate whether it should be performed on external user calls, between 

extensions, or outbound calls for each action. 

 
 

 

 

Note: You can associate more than one action with each event. Likewise, 

it is possible to associate the same action with more than one event. 
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2.8 Audio Settings 
 

 This panel is only available in KATC Phone mode. It allows you to select the audio devices 

to use for audio input (microphone), audio output (to listen to the call), and notifications 

(audio output for the ringtone and other notifications). 

Figure 4 - Audio Settings 
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Chapter 3 - Main Interface 
 

 
 

 

 

Figure 5 - Main Screen 
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Figure 6 - Main Screen 
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Figure 5 and Figure 6 show the main screen of the application, which can be divided into five 
sections: 

- Menu bar 
- Telephone control and status section 
- Calls management section 
- Phonebooks and reports section 
- Inbound calls notification area 

 
Each section will be described in detail in the section below. 

 

3.1 Menu Bar 
 

The Menu Bar has two sub-menus: Settings and View. 

 
The Options menu has the following items: 

• Connect to KalliopePBX: starts the connection with KalliopePBX 

• Disconnect from KalliopePBX: breaks the connection with KalliopePBX 

• Pause on all queues/Cancel Pauses (shortcut CTRL+P): if the local user is an 

operator inserted in at least one call queue, it allows to pause on all the queues 

in which he appears as an operator. 

• Settings: allows you to access the Settings screen (see par. 2.2) 

• Exit (shortcut CTRL+Q): closes the application. 

 
 
 

 

 

 

Note: This command allows the ultimate exit from the application. 

Pressing the  system key does not close the application but minimizes 

it as a system icon. 
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The View menu allows you to configure the display layout of the main screen. 

 

More in detail, the View menu has the following items: 

•  Show numeric keypad: enables/disables the display of the numeric keypad 

 
 
 
 
 

• Lock layout 

• Enlarge mode: enables/disables the main screen’s display in enlarged mode. The 

textual elements of the interface are enlarged to facilitate the use of the 

application by visually impaired users. 

3.2 Telephone control and status section 
 

The Telephone control and status section are detailed in Figure 7. 
 

Figure 7 - Telephone control section 

 

The top left corner (red box) shows the extension number and the username associated with the 
local user (in the example, 202 is the extension number, while "Flavio" is the username). 

The user and queue status LED box (green box) indicates whether the connection to KalliopePBX is 
active or not and shows the status of the local user on the waiting queues ("IN PAUSE" on all 
queues, "PARZ. IN PAUSA" only on some queues, or "ACTIVE"). 

 

 



- 17 - Revision: 08/06/2017 Revised user manual to KalliopeATC 1.2.4 

 

  
Technical support: http://ticket.netresults.it 

 

 

If the user is paused on all queues, the LED will turn red 

, and the application’s icon will turn into the following image. 

. But if the user is paused only on some queues, the LED will turn orange while the  

application icon will not change. 

The Volume Control section is on the right of the keypad (yellow box). This section is 

used to adjust the volume of the listening audio and the microphone level during calls. 

The Telephone Dialing Field (blue box) is a text box for dialing telephone numbers. To 

dial a number or enter a number during a conversation (for example, sending DTMF 

codes), you can click on the box to bring up the text cursor and enter the desired number 

on the keypad. 

The Telephone Dialing Field is also filled in using the numeric keypad. The 

display of the numeric keypad can be enabled/disabled from the View 

menu (see 3.1). The numeric keypad may be more intuitive as it precisely 

reproduces the keys available on any telephone and is even more helpful 

when you use operating systems with a touch interface. 

 

In the Phone Control and Status Section, there are the following buttons: 

 

 Call Start: this button starts a call to the number shown in the Telephone Dialing 

Field (blue box) 

 
Unconditional forward: the unconditional forward function allows you to 

program the KalliopePBX to forward calls to your extension (only calls between 

extensions or external calls to a specific extension, but not call groups) to a different PBX 

extension.  

 

This feature is useful when away from your workstation and you want to redirect 

inbound calls to another extension. Set the number to which all inbound calls are to be 

forwarded unconditionally.  

 

Once you click on this button, you will see the screen where you can enter the number 

you want to unconditionally forward inbound calls to the extension. 
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Figure 8 - Call forwarding screen 

 
Once the unconditional forward service is enabled, the button and the application 

icon will turn red to    indicate that the forwarding service is active. 

 

 

 

 

Note: Unconditional call forward applies only to calls directed to the 

extension and not calls submitted to the extension as part of a group or 

call queue 

 

 
-  Do Not Disturb (DND) service: enables “Do Not Disturb” mode (from now on, referred to as 

DND). The phone automatically rejects all inbound calls (both direct and group calls). 
Once the DND service is enabled, the button and the application icon will turn red to 
indicate that the phone is in DND mode. 

 

 
 
 
 

 

Note: DND service and unconditional forward can be enabled in parallel. 

In this case, calls addressed directly to the extension will be forwarded to 

the indicated number. In contrast, group calls (i.e., addressed to groups 

or queues of which the extension is a member) will find the extension 

unavailable. 
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 Voicemail box: allows direct access to the voicemail box associated with the 

extension (if enabled on the KalliopePBX for the local user). Refer to the KalliopePBX 

manual (Chap. 3.8.6) for a description of the VoiceMail service. 

This button also acts as an indicator of the presence or absence of messages in the 

voicemail. If unheard messages are in the voicemail box, the button will look like this 

. 

 Audioconference service: this button allows direct access to the KalliopePBX 

audioconference service. Please refer to the KalliopePBX manual (chap. 3.5) for 

the description of the Audioconference service. 

 
-  Dual Ring Service: The Dual Ring service distributes the direct call to an extension 

and the associated mobile number if configured in the extension panel. Please refer 

to the KalliopePBX manual (chapter 3.8.12) for the description of the Dual Ring 

service. 

The button is enabled only if the Dual Ring service has been made available for the 

local user at the KalliopePBX level, i.e., if the "Mobile number" field has been 

defined for the local user. In this case, it is possible to check which mobile number 

the Dual Ring service has been associated with by moving the mouse pointer on the 

button and reading the relative Tooltip. Depending on whether the Dual Ring 

service is active or not, the button will have the following icons: 

 
• Dual Ring service active 

• Dual Ring service is not active 

 

 
3.3 Phonebook and reports section 

 

The Phonebook and reports section is divided into the following subsections: 

•    Favorites 

•  Extensions 

•  Phonebook 

•  Call Detail Record (CDR) 
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•  Queues 

 
In the following paragraphs, the individual subsections will be described in detail. 

3.3.1 Extension phonebook 

Figure 9 shows the KalliopePBX extension phonebook panel. 

The "Search Extension" field allows you to search the extension phonebook on First 

Name, Last Name, Company, and Department fields. The search is performed 

automatically, and the table is filtered as the search field is filled in.. 
 

Figure 9 – Extensions phonebook box 

 
The extension table shows the following columns: 

 
• K (client status): this column shows an icon that represents the status of 

the client associated with each extension. 

= client on and connected to KalliopePBX 

= client off or not connected 
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• T (phone status): this column shows an icon representing the phone’s 

status associated with each extension. 

= BUSY 

= FREE 

= (green/red flashing icon) is DROPPING 

= UNAVAILABLE status 

 
• Number: shows the extension number for each phone contact 

 
• Contact Fields (NAME, SURNAME, COMPANY, DEPARTMENT): the extension 

phonebook table can be sorted by each contact field. 

 
• P (preferred field): in this column, there is an icon that indicates whether the extension 

is among the local user's favorites or not. 

 
 = extension is NOT among the favorites  

 = extension is among the favorites 

 
The user can add/remove the extensions from the list of his favorite contacts 

by clicking on the star symbol in this column. 

 

The phonebook of the extensions consists of a table with two levels, a primary and a 

secondary (or detail) one. You can access the detail level by double-clicking on an 

extension’s primary row (Figure 10). 

 

Figure 10 - Information structure of an extension 
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The detail line of an extension shows the extension number. Double-clicking on the 

detail line triggers a call to the indicated number. 

NOTE: By scrolling the extension table with the keyboard’s arrows, you can switch from 
the mainline of the contact to the detail line by pressing the → key and back to the 
mainline by pressing the ← key. Moreover, it is possible to start the call to the selected 
extension by pressing the ENTER key (the detail line does not need to be chosen). 

 
3.3.1.1 Advanced Operations on Extensions 

The extension phonebook panel allows you to perform advanced operations through 

the context menu. The following are all the possible operations available from the 

context menu (which appears by right-clicking on the mainline of the selected 

extension). 

 

  Call: XXX - Make a call to extension XXX 

 Chat: XXX - Starts a chat with extension XXX (ref. chap. 5.1) 

 Attended transfer to XXX - Starts an attended transfer to the extension XXX (this 

option is visible only if there is an active call in progress - ref. chap. 4.2) 

 Forward to XXX - Starts a blind transfer to extension XXX (this option is visible only if there is an    
active call - ref. chap. 4.2). 

 Reserve call - Make a call reservation on busy (this option is visible only if the selected 

extension is busy - ref. chap. 4.4). 

 Pickup: XXX - Starts a direct call pickup from extension XXX (this option is visible only if the 
phone status of extension XXX is "STARTING") 

 Invite pickup: XXX - Starts an Invite pickup from extension XXX (this option is visible only if the 

phone status of extension XXX is "IS RINGING"). 
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3.3.2 External Contacts Phonebook 

 
Figure 11 shows the panel of the KalliopePBX external contact phonebooks (shared and 

personal) and contacts imported from Microsoft Outlook. 

The "Search Contact" field allows you to search the external contact phonebooks on the 

First Name, Last Name, Company, and Details fields. The search is performed 

automatically, and the table is filtered as the search field is filled in. 

In addition to the First Name, Last Name, Company, and Details fields, the table contains 

the T column indicating whether the contact belongs to the shared company phonebook 

or the local user's phonebook. 

 

 = the contact belongs to the shared company phonebook 

= the contact belongs to the personal phonebook 

= the contact has been imported from Microsoft Outlook 

 

 The button opens the screen for inserting a new contact into your phonebook 

(see Figure 12). 
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Figure 11 - External contacts phonebook box 
 
 

Figure 12 - Insertion/editing contact screen 
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The phonebook of contacts is a table with two levels, a primary and a secondary (or 

detail) one. Double-clicking on the mainline of an extension will give access to the detail 

level (Figure 13) composed of several lines, one for each contact information (phone 

number, email, etc.). 

 

Figure 13 - Structure of the contacts phonebook 

 

In the detailed lines of contact, the contact information is shown, one per line, 

distinguished by type with a specific icon: 

 Phone number 

 Email address 

 
By double-clicking on the detail line, depending on the type of information it contains, the 

following actions are triggered: 

• call initiation to the number indicated in the detail 

• send an email with the default email software at the system level 

 
NOTE: scrolling the contact table with the keyboard arrows, you can switch from the 
main contact line to the detail line by pressing the → key and back to the mainline by 
pressing the ← key. Moreover, using the selected contact detail (call the number or send 
the email) is possible by simply pressing the ENTER key. 

 
 

3.3.2.1 Advanced Operations on Contacts 

The contact phonebook panel allows you to perform advanced operations through the 

context menu. In particular, options related to the detailed information available for 

contacts are shown in the menu (Figure 14). 
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Figure 14 - Contextual menu of the contacts phonebook 

 
In addition to the commands related to detail contacts, the contextual menu contains 

commands to delete or edit contact information if the contact belongs to the personal 

phonebook. 
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3.3.3 Call Detail Record (CDR) 

Figure 15 displays the box that shows the call log for the local user. 
 

Figure 15 – CDR box  

 

 
This section shows the detailed log of all the local user's calls on his extension made and 

received. The report is divided into three columns: 

• Call type (T): indicates the type of call using the following icons 

 Outbound calls not answered or failed    

Inbound call not answered or failed    

Outbound call answered correctly 

 Inbound call answered correctly 
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 The call ended in voice mail 

 

• User: information about the call partner. If the number is present in the 

phonebook, the name of the caller is also shown in this field 

• Date: the date, start time, and duration of the call 

 
In the CDR Search box, it is possible to carry out CDR searches based on the caller's 

date and number/name. 

 
 

 

 

 

Note: By right-clicking on a CDR row, you can, via the contextual menu, 

recall the selected contact and, if not present, add the contact to the 

phonebook. 

 

 

3.3.4 Queues (queue statistics) 

The Queues section is marked with the symbol  . 

In this section, it is possible to monitor the status of the queues in real-time. If the local 

user is an operator, he will only be able to see the queues he is a member of and have 

access to his statistics. If the local user has the supervisor role, he can see all the 

queues on the KalliopePBX and monitor each operator's statistics. Figure 16 shows the 

statistics monitoring window of a single queue. 
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Figure 16 - Queue statistics monitoring window 

 
The following statistics are shown in each monitoring window: 

• Num. Users in queue: the instant number of external users waiting in the queue. 

It is expressed in the form X/Y where X is the number of users waiting at that 

moment and Y is the maximum number of users that the queue can accept 

(depending on how it has been configured). 

• Missed calls: the number of calls that arrived in the queue but were not served 

because the remote user closed the call before speaking to an operator. 

• Average Waiting Time: the average waiting time experienced by those accessing 

the queue (in seconds), based on the history of received and worked calls. 

• Processed calls: indicates the number of calls received in the queue and served 

by operators. 

 
The table below shows the following information for each operator in the queue: 

• Number of calls handled 

• Date and time of the last handled call 

• Pause Status: indicates if the operator is paused or not 

 
By right-clicking on his extension, the operator can pause  on 

that queue while remaining active on the other queues. Remember that the operator 
can pause all the queues by typing the key combination CTRL + P or through the Options 
menu on the Menu bar (ref. chap. 3.1). 
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Note: If the local user has the Supervisor role, they can pause or un-pause 
any operator. 

 

 

3.4 Inbound calls notification area 
 

This section consists of five indicators that light up and show the number of inbound 

calls for each type: 

• Calls coming from a queue 

• Direct external calls 

• Local calls 

• Transferred returns 

• Calls on hold 
 
 

 

Figure 17 - Inbound calls notification area 

 
Each type of call is matched to a shortcut that allows answering quickly using the 

keyboard: 

 
F1 = Answer to external calls on queue  

F2 = Answer to direct external calls 

F3 = Answer to direct internal calls  

F4 = Answer to call returns 

F5 = Put on hold. 

 
In the case of several calls of the same type, keyboard shortcuts allow you to take 

charge of the oldest call. 
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Chapter 4 - Call Management 
 

 
Inbound and outbound calls are managed by panes that fill the Call Management Area, 

shown in Figure 17. 

The Call Management Area is located between the Telephone Control and Status section 

and the Inbound Call Management section and consists of two sections: Calls in Progress 

and Calls on Hold. You can move a call between sections, put it on hold or resume it by 

dragging it with the mouse or with your finger in the case of touch devices. 

Depending on the status of the call, the corresponding box will take a specific shape and 

color and present the appropriate control buttons. 
 

Figure 17 - Call management area 
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4.1 Inbound call 
 

The box shown in Figure 18 appears in the Call Management Area when a call comes in. 

The box has a flashing appearance (red/orange) and comes with an audible notification. 

 
 

 

Figure 18 - Inbound call box 

As shown in the figure, besides the indication of the caller, the user can choose specific 
operations that are available: 

 
• Answer call 

• Reject call 

• Divert call 

• Ignore call 

 
In addition to the Inbound Call panel, the Inbound Call event generates (if enabled in 

the Settings menu) a popup notification like the one shown in Figure 19. 
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Figure 19 - Inbound call alert popup 

 

The popup is convenient if the application is minimized as a system icon, and 

therefore, the Call management area is not visible. It is possible to perform the same 

operations available in the Inbound Call panel through the popup. 

 
 

4.2 Active call 
 

When a call is active, the box shown in Figure 20 appears. 
 
 

 

Figure 20 - Active call box 

The user has several operations available:
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• Blind transfer 

• Attended transfer 

• Put the call on hold 

• Call recording 

• Close the call 

• Cancel call transfer 

 
Refer to the KalliopePBX manual for the meaning of the telephone services listed above. 

The call duration and microphone level indicator are also shown. 

 

The call forwarding service is managed in such a way as to allow phonebooks to be 

consulted during the forwarding process: the call is put on hold, and a tooltip tells the 

user to enter the number to which the call should be transferred in the dial pad. 
 

 
During the transfer, no popup appears, leaving the user free to consult the list of 

extensions or the phonebooks; in this case, once you select the extension to which you 

want to transfer the call, you can complete the transfer by pressing ENTER or F6 (for 

blind transfer) and F7 (for transfer with offer). 

 
 

 
 
 
 

 

Note: it is possible to have only one active call at a time. Therefore, if a 

new call arrives or you want to make a call while in an active call, the 

application asks you to confirm, reminding you that the operation will 

automatically pause the active call. 
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4.3 Call on Hold 
 

When a call is on hold, its Active call panel disappears, and the box shown in Figure 20 appears. 
 

Figure 21 - Call on hold box 
 
 

Just click on the Call on Hold box to resume a call on hold and make it active again. 

 
 

 
 
 

 

Note: Since you can only have one active call at a time if you want to 

resume a call when another call is active, the application will ask for 

confirmation reminding you that the operation will automatically pause 

the already active call. 
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4.4 Call reservation 
 

When a call has been reserved because the other party is busy, the Call booked box shown in 
Figure 22 appears. 

 

Figure 22 - Call booked box 
 

The reserved call box remains visible until the booked caller is free. The Call booked box 

disappears, and a call is made to the requested subscriber. If it is no longer necessary to 

keep the reservation, it is possible to cancel it by pressing the appropriate button shown 

in Figure 22. 
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Chapter 5 - Other Services 
 

 

In addition to telephone functionality, the KATC application provides an Instant 

Messaging service between extensions. 

5.1 Instant Messaging 
 

Using the contextual menu of the phonebook of extensions and favorites (ref. chap. 

3.3.2.1), it is possible to activate an Instant Messaging session with the selected 

extension. The option is only enabled if the selected extension has the client active and 

connected to KalliopePBX. 

 

Figure 23 - Instant Messaging Screen 

 

Figure 23 shows the Instant Messaging screen through which you can exchange text messages 
with other extensions. 

The text message must be written in the appropriate edition field while sending by pressing the 
ENTER key on the keyboard. 

 
On the screen, there are also the following two keys: 
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• SAVE CHAT: allows to save on a text file the content of the message exchange 

• SHARE CHAT: it allows to pre-package, through the default e-mail client of the 

system, an e-mail containing the exchange of messages. 

 
 

5.2 Plantronics API Integration 
 

Thanks to the integration of the native APIs, KalliopeATC fully interfaces with Plantronics 

devices. 

At each startup, the application detects the presence of a Plantronics device connected 

to the system in use. If positive, the system automatically chooses this device as default 

for audio input/output. 

Once detected, you can use the headset controls to adjust volumes and answer or end 

a call once detected. 

If the Plantronics device is connected later, a software restart is required to detect the 

device when the application is already running. 
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Chapter 6 - Shortcuts 
 

 

Kalliope Attendant Console has been specifically designed to be easily managed 
through convenient keyboard shortcuts. 

Below is a list of available shortcuts: 

 
Kalliope Attendant Console 
 

F1 = Answer calls coming from a queue  

F2 = Answer direct external calls 

F3 = Answer direct extension calls 

F4 = Answer call returns 

F5 = Put on hold 

CTRL + F5 = Retrieve oldest waiting call  

F6 = Blind Transfer 

CTRL + F6 = Blind transfer with consultation 

F7 = Attended transfer (after having chosen and called the number to which the call will be 

transferred, press F7 again to complete the transfer) 

CANC = Cancel transfer 

F8 = Move cursor to dialing field  

F9 = Favorites tab 

F10= Extension Tab (extension search field) 

F11= Phonebook tab (text field for searching contacts in phonebook) F12= CDR tab (text 

field for searching CDR) 

END = End call 


